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FCC Radio Frequency Interference Statement

This product has been tested and found to comply with the
limits for a class B digital device, pursuant to Part 15 of
the FCC rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that may
cause undesired operation. The FCC Class B limits are
designed to provide reasonable protection against harmful
interference in a residential installation. This equipment
generates, uses, and can radiate radio frequency energy
and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio
communications. However, there is no guarantee that
interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or
television reception, which can be determined by turning
the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following
measures:

= Reorient or relocate the receiving antenna.

= |ncrease the separation between the equipment and
receiver.

= Connect the equipment into an outlet on a circuit
different from that to which the receiver is connected.

= Consult your point of purchase or service representative
for additional suggestions.

CE Warning

This product satisfies the Class B limits of EN55022, EN55024
and safety requirements of EN 60950.



Disposal of Waste Equipment

B

This symbol on the product or on its packaging indicates that
the product can not be disposed of with your other household
waste. Instead it should be sent to appropriate facilities for
recovery and recycling in an effort to protect human health and
the environment. Fore more information about where you can
drop off your waste equipment for recycling, please contact
your local city office, your household waste disposal service or
the shop where you purchased the product.

As an ENERGY STAR® Partner, Avision Inc. has

determined that this product meets the ENERGY STAR
guidelines for energy efficiency.



System Requirements

IBM compatible PC 586, Pentium or higher
Microsoft Windows 98SE/Me/2000/XP/Vista
USB port 2.0 (compatible with USB 1.1)

At least 100 MB of free hard disk space

At least 128 MB of system memory

A CD-ROM drive
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1. Introduction

Congratulations on your purchase of the color image
scanner. With this scanner, you can quickly scan documents
to increase productivity.

Before you install and operate the new scanner, please take
a few minutes to read through this manual. It provides
proper instructions for you to unpack, install, operate and
maintain the scanner.

The following figure indicates the package contents. Please
check all the items against your checklist. If you do not
receive all the items, please contact your authorized local
dealer immediately.

1.Scanner main unit
2.Power adapter
3.Power cord

4.USB cable
5.User’s manual/CD
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Note:

1.

Only use the AC adapter (HEG42-240200-7L made by HiTron)
included in the machine. Using other AC adapters may damage
the machine and void the warranty.

Please unpack the packing carefully, and check the contents
against the checklist. If any items are missing or damaged,
please contact your dealer immediately.
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2. Scanner Installation

Precautions

= Keep the scanner out of direct sunlight. Direct
exposure to the sun or excessive heat may cause
damage to the unit.

= Do not install the scanner in a humid or dusty place.
= Be sure to use the proper AC power source.

= Place the scanner securely on an even, flat surface.
Tilted or uneven surfaces may cause mechanical or
paper-feeding problems.

= Retain the scanner box and packing materials for
shipping purposes.
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2.1 Removing the shipping lock

Unlock the scanner by moving the lock switch to the “Unlock”

position. (Refer to the Lock/Unlock figure on the side.)

Locked

Unlocked
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2.2 Loading the Paper with ADF

Place your document with the text face up and make the top of
the page to the left side as shown below.

Feed Direction

, R /////

Top of Page
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2.3 Fixing Paper on the glass board

Align the document to the reference mark, as indicated.

reference
mark
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2.4 Installing the Scanner Driver and Cables

Note:

1. The Windows system CD may be required when installing
on some PC’s.

2. To ensure your computer can identify the USB scanner,
please install scanner driver first before connecting the
scanner to your computer.

2.4.1 Connecting to Power

Plug the small end of the power adaptor into the power jack of
your scanner. Insert the other end to an appropriate power
outlet.

I

Press the power switch to the “I” position to turn on the
scanner. To turn off the scanner, please press the power
switch to the “O” position.

Power Cable
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2.4.2 Installing the Scanner Driver

1. Place the supplied CD-ROM onto your CD-ROM drive.

2. The software installation graphic appears. If not, run
“setup.exe”.

www.avision.com

Install Button Manager

Install Scanner Driver

Install Adobe Reader

View Manuals
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Contents on the installation graphic:

¢ Install Button Manager: To use the buttons on
the scanner, you need to install Button Manager. To
ensure Button Manager works properly, please FIRST
install Button Manager before installing the scanner
driver.

e Install Scanner Driver: To communicate with your
scanner, you need to install the scanner driver.
After installing the Button Manager software, click
Install Scanner Driver to install the scanner
driver on your computer.

e Install Adobe Reader: To view the user’s manuals
for the scanner and Button Manager, you need to
use Adobe Reader to open and view the manuals in
pdf file format. If you already have Adobe Reader

installed on your computer, you may disregard this
item.

¢ View Manual: Click “View Manual” to view or
print the detailed user manual for the scanner and
Button Manager respectively.

3. Click Install Button Manager to install the Button Manager
software and then click Install Scanner Driver to install the
scanner driver on your computer.
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2.4.3 Connecting to Computer

1. Connect the square end of the USB cable to the USB port of
your scanner. Connect the rectangle end to the USB port of
your computer.

\— USB cable

2. The computer should detect a new USB device and prompt a
“New Hardware Found” message.

New Hardware Found

% UUSE Scanner

Wwindows has found new hardware and is locating the software for it.

(Windows 9X/Windows ME)
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3. In Windows 98SE, Windows ME, or Windows 2000,
confirms that the “Search for a better driver.” is
selected and click the “Next” button.

Add New Hardware Wizard

“Windows has found the following new hardware:

USB Scanner
Windows can automaticaly search for and irstall software
Htat supports bour hardware. |F your hardware came with

installation media, insert it now and click Mext.

What would you like to do?

£ Butomatic search for a better diiver [Hecammended]

' Specify the losation of the diiver (Advanced)

ciack [ Mews | Cancel

In Windows XP, click the Next button to continue. When
the XP certification screen appears, click Continue
Anyway to complete the installation.

In Windows Vista, click the Recommended option, and
then click Continue button to complete the installation.

4. When the Finish dialog is prompted, click the Finish
button.

5. Click “*View Manual” to view or print the detailed user
manual for the scanner and bundled applications
respectively.

Note:
To uninstall the scanner driver in Windows XP or Windows 2000, be
sure to keep your scanner connecting to your computer.
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3. Completing Your First
Scan

3.1 Verifying Your Scanner Installation

To verify if your scanner installation is correct, Avision provides
you a useful test program called Avision Capture Tool. With
this tool, you can perform simple scans and view the captured
images. In addition, it helps you complete your scan at a rated
speed.

The following procedure describes how to verify your scanner
installation. If the installation is not correct, please review the
preceding section to check if the cable connection and scanner
driver have been successfully installed.

Before you begin, be sure the scanner is on.

1. Select Start=Programs=>=Avision AVxxx Scanner=>Avision
Capture Tool.
The Select Scanner Model dialog box will be displayed.

Select Scanner Model EI

Driver Type:
ThfAlN

2. Select your driver type and scanner model and click OK.
The following Avision Capture Tool dialog box will be
displayed.
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5.

Fit Actual

Page Size
[ Avision Capture Tool (TWAIN) - Avision AVkxx
Fle View About
: L) | 5 = [
.@Samp ‘Vlsm ||ﬂ_| Fﬂlenmmt BvP ] [Cy Scennags — Q D
[ |
' . Save File Path
File Format
Scan
Setup

Choose your desired file format from the File Format drop
down list box. (Default is BMP, other choice includes TIFF,
GIF, and JPEG.)

Type your desired folder name and file name in the File
Path box. (Default is C:\My Scan\Image.)

Note: If you do not wish to save the scanned image,
deselect the Save button since default is Save Enable. In
this case, the thumbnail view will be disabled. And
therefore, after viewing all the scanned images, only the
last one will remain on the screen.

‘@_ He
Click the Setup button ( WJ tLllJ) or choose Setup from the
File menu to prompt the Scanner Properties dialog box.
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10.

Sconner Properties [x]

Image | Compression | Color Dropout | Paper | Breview | Options | Setting | Information |
[Domic Tuwshall <]
[ |Front Gray
Rea Grny Kl |
Im age VIFront B&W
S | t. [IRear B&W Erightness 04 il |
election [ [Front Auto Color Detection .
B Reex Ao Color Detection Gt o4 _ Bl
OX
Resolution (dpi): T
Invert: [Block on Whit |
Sean Souree: [ Auto Document Feeder |
Profiles | [Costom =]
[~ Color Adjnstment
Bl oK Close

From the Image Selection Box, choose your desired image
type for your scanned image. (Default is Front B&W) If
you have a duplex scanner, choose Front and Rear to scan
both sides of your document.

Click OK to quit the Scanner Properties dialog box. (To
learn more details about the Scanner Properties dialog box,
please see the subsequent chapter, Using the Scanner
Properties Dialog Box.)

Place your document face down on the document glass or
face up in the auto document feeder.

In the Scan Validation dialog box, click the Scan button

.ﬁ Bran i
( ) or choose Scan from the File menu.
The document will be scanned and displayed in the Scan
Validation screen. After the scanned images have been
displayed, your scanner installation verification is
completed.
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EE Avision Capture Tool (TWAIN) - Avision AVxxx

File ¥iew Abont

@Semp f Sean

% BleFomst  |BMP | [City Scaniimage | |@ D

A n\dmuﬁa

4 4 &

=

%%
m
P = T
e

I
— =

i OV

Fife Neme:Image_001 binp, Image Type Color, Width: 1640, fength 2339, Resoluion:200 dpi, Image §zeil 1507 88 Khytes

' Status Bar ' Fit Page View

Thumbnail View

. You can view the scanned image in Fit Page (‘Q‘) or
Actual Size (100%) button (D ) from the Viewing toolbars
at the right side.

. Click the Close box or Quit from the File menu to exit the
Scan Validation Tool.



3.1.1 A Glance of the Scanner Properties Dialog Box

Scanner Properties (B3
1 _ Image | Compression | Color Dopout | Paper | Breview | Options | Setting | Information |
[Foont Gsy
Rear Gray [ |
[v[Front B&W
2 [Resr BE&W Brightoess: GIET| | —=t— 3
[[TFeont Auto Color Deteetion
[ [Reex Auto Color Detection el 04 Bl =, 4
Reesalution {1pi} 200 - .5
- Eodonwhie 02— 6
Soan Sourve: | Antn Document Feeder = | 7
Profles | [Costom =l
I~ Color Adjustment

1. Tab Options

Choice: Image, Compression, Color Dropout,
Paper, Options, Settings, Information.

2. Image
Selection Box

Choose your image type and the side of
document you wish to scan. Options vary
based on type of scanner.

3. Brightness:

Adjust the brightness level from —100 to +100.

4. Contrast

Adjust the contrast level from —100 to +100.

5. Resolution

Determine the quality of the scanned image.
The industry standard is 200 dpi.

6. Invert

Reverse the color of your scanned image.

7. Scan Source

Choice: Auto Document Feeder, Flatbed,
Flatbed (Book), Automatic (varies due to
different scanner model)

8. Defaults

Reset all values on the tabs to the factory
default settings.
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4. Using the Scanner
Properties Dialog Box

The Scanner Properties dialog box allows you to configure the
scanner’s settings. It consists of several tabbed windows each

of which will be described in this chapter.

Scanner Froperties

Image lComprea&on] Color Dmpout] Paper ] Preview ] Opﬁom] Setting ] Infonmdion]

Rear Color | =]
S « 5]
IFront B& Y
[[Rear B&W Brightness: 04 ] 2l
e A e Dotion. | Gt 04l _ o
Resolution (pi: [200 =1 |
Lovert: [Black on White =]
Scan Source: | Auto Document Feeder =]
Profibs | [Costom =
[ Calor Adjustment
Sean | Close

The Scanner Properties dialog box
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4.1 Buttons on the Scanner Properties Dialog Box

Tmage ICompxemn] ColorDmpout] Paper ] Previ.ew] Opti.ons] Setting ] Infomati.on]

e Colo | =
S 4 g
WFront B&T
[ |Rsar B&W Brightress 04 _ ]
Drbon St | AT A
Resolution {dps): [200 = - ]
Invert: [Black on White |
Scan Source: [Auto Document Feeder =1
Frofiles | [Custom =]

[~ Color Adjustment

Scan ‘ Close |

The buttons on the Scanner Properties dialog box

Buttons | Description

Defaults | Click the Defaults button, the factory default
settings will be shown on each tab.

Scan After all the scan settings are satisfactory, click
the Scan button to start scanning your
document.

Close Click the Close button to leave the Scanner

Properties dialog box.
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The following table shows the default settings :

Tab name Default settings

Image Image : Front B&W

Binarization : Dynamic Threshold
Resolution : 200 dpi

Invert : Blank on White

Scan Source : Auto Document Feeder
Threshold : None

Brightness : None

Contrast : None

Compression None

Color Dropout | None

Paper Cropping : Automatic
Deskew : Yes

Orientation : Portrait
OverScan : 0.00

Multifeed Detection : None
Unit : Inch

Options Rotation Degrees : None
Blank Page Removal : None
Edge Fill : White > O mm
Image Control Option : None

Setting Enable Energy Saver : Enable, 15
minutes after last scan action
Show Scanning Progress : Yes
Show Warning Message : Yes
Save Settings after Closing : Yes
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4.2 The Image Tab

The Image tab allows you to choose the front side and (or) the
rear side of your document, the type of image, and to set
several basic scan settings. Note that except for the resolution,
you can set individual scan settings for the front side and the
rear side. For example, all settings in the Image tab,
Compression tab, Color Dropout tab can be set individually for
the front and the rear side. However, the settings in the Paper
tab, the Option tab, and the Setting tab have to be set the
same for the front and rear side.

Scanner Froperties X |

Image lComprea&on] Color Dmpout] Paper ] Preview ] Opﬁom] Setting ] Infonmdion]

| =
Do Gy 4 2]
[w]Front B&W
[Rear B&W _ Brightness: 04 Il o
Ren i Cor Dot | SO 0] - 2|
Resalution (dpi): [200 =1 |
Lowvert: |Ellack on White ﬂ
Sean Source: |Auiu Document Feeder ﬂ
Profiles |Cu.s1um ﬂ
[ Color Adjustment
Scan Cloze

The Image tab dialog box



4.2.1 The Image Selection Box

% Front Color The Image Selection box includes
[WRear Color the image type and document side
[JFront Gray option. If you wish to scan both the
[ |Rear Gray front side and the rear side of your
[ Front B&W

Rear BaW color document, you can check both

[ [Frant Anto Color Detection Front Color and Rear Color at the

[Rear Auin Color Detsction same time. Note the options vary
based on type of scanner.

Example 1 : Scanning a two-sided color document, both
sides in color

Front Calar " ==
[w]Fear Color

[ Front Gray

[ R ear Gray

[ Front B&W

[ Rear B&W

[1Front Avto Color Detection
[Rear Auto Color Detection

Side/Image
Selection
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Example 2 : Scanning a two-sided color document, one
in B&W(Drop Blue Color : Threshold : 10, Background :
79), the other in color

Front Color

[ |Front Auto Color Detection
[JRear Auto Color Detection

Side/Image u

Selection Front Rear

Image Type | Description

Color Choose Color if you wish to scan a color
image for your original in color.

Gray Choose Gray image if your original contains
actual shades of gray.

B&W Choose B&W if your original contains only text

pencil or ink sketch.

B&W

Gray




Front/Rear Auto Color Detection:

Click to automatically detect and scan the front or the rear
page of your color document in color image mode. If your
document is in colors, the scanner will automatically scan the
document into a color image. If your document is non-color,
you can choose the output to be either B&W or Gray from
the Non-Color Selection option. This option is useful when
you have a mixture of color and non-color document.

Note: If you choose Front Rear Auto Color Detection, you
can not specify the image mode of your rear page and vice
versas.

Scanner Properties |

Image ]Cnmpmmn] CnlnrDrnpnut} Paper I Prewew] Ophnns] Setting ] Infnmahﬂn]

[(Front Colar R
CJRest Color Non-Color Selection: |Black and hite |
[CJFromt Geacr
[CRear Gray JEA| ]
[(JFront B& W
T Do Brightness: 1] ﬂ J ﬂ
Front 4utn Color Detection .
[CIRear Anto Color Detection Clomiestt y ﬂ J ﬂ
Resolution (dpi) |ZDD ﬂ
Invert: |Elack on White j
Scan Source: |4 uto Document Fesder |
Profiles |Cmm ﬂ
[ Color Adjustment
Diefaults... Scan Cloge

4-7



4.2.2 Other Image Options

Binarization

This is the process of converting a
grayscale or color image to a bi-tonal
image. There are several different
methods of performing this conversion.
Two of the options are Dynamic
Threshold and Fixed Processing.

Dynamic Threshold: Selecting
Dynamic Threshold allows the scanner
to dynamically evaluate each document
to determine the optimal threshold value
to produce the highest quality image.
This is used to scan mixed document
containing faint text, shaded background,
or color background with a single setting.
If Dynamic Threshold is selected,
Threshold, Brightness, and Contrast are
not available.

Fixed Processing: Used for black-and-
white and other high contrast documents.
A single level is set to determine the
black-and-white transition. The threshold
is programmable over the entire density
range. Fixed Processing sets Contrast
to 0. If Fixed Processing is selected,
Contrast is not available.
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Threshold

Used to convert a grayscale image to a
bi-tonal image. The value ranges from O to
255. A low threshold value produces a
lighter image, and can be used to subdue
backgrounds and subtle, unneeded
information. A high threshold value produces
a darker image, and can be used to help pick
up faint images.

Adjust the threshold setting by dragging the
Threshold sliding bar to the left or right to
achieve the desired threshold setting.

200 dpi, 200 dpi,
Threshold:80, Threshold:170,
Brightness: O Brightness: O
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Brightness Adjusts the lightness or darkness of an
image. The higher the value, the brighter
the image. Drag the slider to the right or
left to increase or decrease the brightness.
The range is from —100 to +100.

Contrast Adjusts the range between the darkest and
the lightest shades in the image. The
higher the contrast, the bigger the different
grayscale. Drag the slider to the right or
left to increase or decrease the contrast.
The range is from —100 to +100.

i
Brightness: -50 Brightness: O Brightness: +50
(Normal)

Contrast: -50 Contrast: +50

(Normal)
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Resolution

A good control of the resolution results a
good detail of an image that scans. The
resolution is measured by dots per inch
(dpi). Normally, the greater the dpi number,
the higher the resolution and the image file
size. Be aware that greater resolution takes
more time to scan, and more disk space for
the scanning image. For your information,
an A4 size color image scanned at 300 dpi at
True Color mode consumes approximately 25
MB of disk space. A higher resolution
(usually means over 600 dpi) is only
recommended when you need to scan a
small area at True Color mode.

Choose a resolution value from the drop
down list. The default value is 200 dpi.
Available resolutions are 75, 100, 150,
200,300, 400 and 600. Or you may choose
your desired value by clicking the box in the
right side of the drop down list and press the
arrow key to select your desired value and
then click the Add button to include it in the
drop down list.

-
Resolution: 75 dpi

Resolution: 150 dpi
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Invert Reverses the brightness and the colors in the
image. The default setting is Black on a White
background. Reverse mode is White on a Black
background. For color images, each pixel will be
changed into its complementary color at the
command of Invert.

“E am not worthy to have you enter my

:that is God, I beqg all my brothers - those w
e who work manuaslly, clerics and lay brothers
ards belng humble in all things; nat to glorify
r to become interlorly proud because of good w
sametimeas says or does in them or through tl
ard:  “Do not rejoice--- in the fact that the de
£ 10:20} Let us be firmly convinced of the fact

Black on White

“I am not worthy t¢ have you enter m

that is God, I beg all my brothers - those v
E who work manually, clerics and lay brothe

rds being humble in all things; not to glority
to becorne Interlorly proud because of gand
sometimes says or does in them or through 4
rd:  “Do not rejoice--- in the fact that the dd
10:20) Let us be firmly convinced of the fa

White on Black
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Scan
Source

Choice:

Auto Document Feeder: Used to scan
multiple pages.

Flatbed: Used to scan a single page. For
example, pages from newspaper clipping,
paper with wrinkles or curls.

Flatbed (book): Used to scan several
inside pages from book.

Automatic: Allow the scanner automatically
set its scan source. If Automatic is selected
and there is document in both the auto
document feeder (ADF) and the flatbed, then
the scan source will be automatically set to
ADF. If Automatic is selected and there is
document only in flatbed, then the scan
source will be set to flatbed.

Merge Two Sides into One Image:

If you have a sheet-fed duplex scanner with
front input tray (eg. AV220C2), you can scan
an A3 size document with an innovative
method. Thus, fold your A3 size document
into A4, and then load the paper in the front
tray. Choose Merge Two Sides from the
Scan Source option and then the scanner is
able to scan both sides of your document
and merge two A4 images into one A3
image.

When you select Merge Two Sides into One
Image, the Cropping or Multi-feed function
will be disabled.

Note the options vary based on type of
scanner.
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Color

Adjusts the color quality of the image so
Adjustment

that it comes close to that of the original.

This function uses default parameters to
adjust the image.

After Color Adjustment

4.2.3 Scanning color images

The following options are available for scanning color images.

. Brightness

. Contrast
. Resolution
. Invert
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4.2.4 Scanning grayscale images

The following options are available for scanning gray images.

. Brightness

. Contrast
. Resolution
. Invert

4.2.5 Scanning B&W images

The following options are available for scanning B&W images.

. Binarization (Dynamic Threshold)
. Resolution
. Invert
Or
. Binarization (Fix Processing)

. Threshold

. Brightness
. Resolution
. Invert
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4.2.6 Editing Profiles

The Scanner Properties dialog box allows you to change and
save your frequently used scan settings into a profile. You can
edit these profiles by renaming or deleting them.

To add a new profile,

1. Customize your settings. (For example, change your
resolution, image type, cropping method, scan size, or
other scan settings.)

2. Click the Image tab and then choose “Profiles” to prompt
the “Edit Your Profile” dialog box.

tonge | Comprssion | Galor Dot | Fpes | Fovv | Opons | Seag | Idormasian

EEX

Seap Bowees: [ aks Docuraned Foober

-“I -
I Colar Adstrsest

s | ome

3. Click “Add” to enter the name of the profile and then
choose “Save”.

Add A New Profile

Fleaze enter the name of the profile:

[
Save | Cancel |

4. The new profile will be saved and shown in the “Profiles
dropdown list box.
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To load a profile,

From the Image tab dialog box, choose your favorable
profile from the “Profiles” dropdown list box.

Edit ¥our Profile EJ @‘ E‘

Profile:

ot
Simplex - B&W, 200dpi
Simplex - Color, 200dpi
Simplex - Crray, 200dpi

Your favorable profile will be immediately loaded and
displayed on Scanner Properties dialog box.

To delete a profile,

1.

From the Image tab dialog box, click “Profiles” to prompt
the Edit Your Profile dialog box.

Edit Your Profile

Profils

Rename Reset

Choose the profile you want to delete from the dropdown
list box.

Click “Delete”. A Confirm message “Are you sure you
want to delete this profile?” is prompted.

Choose “Yes” to delete or “Cancel” to quit.
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To rename a profile,

1. From the Image tab dialog box, click “Profiles” to prompt
the Edit Your Profile dialog box.

Edit Your Profile

Profile:

ot
Simplex - B&W, 200dpi
Simplex - Color, 200dpi
Simplex - Crray, 200dpi

2. Choose the profile you want to rename from the dropdown
list box and then click the Rename button.

3. Enter new name for the profile.

Rename a Profile gl

Pleaze enter the new name of the profile:

Origina] Nome: | Beteyr

Wew Wame: |

Caneel |

4. Choose “Save” to save the new profile or “Cancel” to quit.

Note:

The preset default profiles include Flatbed, Simplex-B&W, 200
dpi, Simplex-Gray, 200 dpi, Simplex-Color, 200 dpi, Duplex-
B&W, 200 dpi, Duplex-Gray, 200 dpi, Duplex-Color, 200 dpi. If
you have a simplex or a sheetfed scanner, the duplex or the
flatbed option will not be available.
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4.3 The Compression Tab

The Compression tab allows you to compress your scanned
image and choose the level of compression. Bi-tonal images
are normally compressed using CCITT standard called Group 4
(G4). Color and grayscale images are often compressed using
JPEG technology. Move the JPEG Quality slider to the right or
left to increase or decrease the level of compression. Note the
greater the compression level, the lower image quality. Default
is 50%.

Note that the compression depends on your image editing
application. If your image editing application does not support
the type of compression format, then either a warning
message will appear or the image quality of the compressed file
will not be acceptable.

JPEG (Joint Photographic Editor Group). This group developed
and lent their name to a file compression standard for color and
grayscale images that is widely used by scanners, and software
applications. On Microsoft Windows-based systems, a file with
the extension .jpg has normally been compressed using this
standard.

For scanning color or gray images, the following compressions
are available:

. None

. JPEG

For scanning B&W images, the following compressions are
available:

. None

. G4
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Scanner Froperties

Image  Compression ICo].or Dmpom] Paper } Pxeview] Opnons} Setting ] Infomanon}

Y

| [Rear Color ComprEsmye [ Qane) =1
[ IFront Gray

[IRear Gray }—
[wFront B&W

[ JRear B&W

[ JFront &uto Color Detection
[ |Rear Auto Color Detection

Defaults. Scan | Close

The Compression tab dialog box
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4.4  The Color Dropout Tab
4.4.1 Color Dropout Selection

Color Dropout tab allows you to drop either of the red, blue, or
green color in your scanned image. If your image contains red
color watermark or background, choose the R (Red) channel
then any red watermark or background will be removed. This
feature is used to sharpen your text when using OCR (Optical
Character Recognition) software.

Note that this function supports only black & white and gray
images. Therefore, be sure to choose any black & white or
gray image type while applying this function.

Scanner Properties |

Image | Compression Color Dropout wPaper | Preview | Options | Setting | Information |
Color Dropout |Remnve Red ﬂ
Az ioses
Filter Threshold: 0 4] 1 |
Kl ol
[Rear Auts Color Detection
Defaults. Scan Close

The Color Dropout dialog box
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4.4.2 Other Color Dropout Options

Advanced Processing provides two options that can adjust
your scanned image in the best optimal result.

Filter This value is used to determine the color

Threshold which will be dropped out. A lower value will
drop more of the selected color out, while a
higher value will leave more of the selected
color in.

Background The pixel which is higher than the

Level background value will be adjusted to the
lightest point. Adjust the value for both the
Filter Threshold and Background Level to
produce the best optimal result.

Example, slightly adjusting the background value makes
your text more clear.

AMB120EESIHERSIIRE

Original
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Remove Blue, Threshold: 20, Background:
255

AME120F: B B IIIEM S MG

Remove Blue, Threshold: 20,
Background Level: 210
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4.5 The Paper Tab

The Paper tab allows you to define values relating to image
output (i.e., Auto Crop or not, Scan Area, OverScan, Multi-Feed
Detection).

Scanner Properhies |

Image ] Compression] Color Dropont - Paper ]Preview ] Opﬁon,s] Setting ] In.fomlaﬁon]

Cropping: |Fi}nerl o Tramsport ﬂ
r
Soan drea: |ISO A5 - 148 x 210 mm ﬂ
i+ Portrait ™ Landscape
= B
V-Offset: (T
Width 582 = -
Length: 826 il |v Center
Orverdean: :I :I
Tap: 0.00 -+ Botiom: 0.00 -
Multi-Feed Detection
Jv Ldditional Length Detection: 202 il
[ Ultrasonde Detection
v Stop Seanning after Mulh-Feed:
Cleax the Multi-Fed Paper: * Manual " Auto
Multi-Feed Alarm: Qome) = @ Bowe.
Unit [Tnches =]

Defaults... Scan | Cloze |

The Paper tab dialog box
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4.5.1 Cropping

Cropping allows you to capture a portion of the document
being scanned. Choice: Automatic, Fixed to
Transport, EOP (End of Page) Detection.

Options

Description

Automatic

Automatic adjusts the cropping window
according to different document sizes. Use
this option for batches of mixed-sized
documents.

Fixed to
Transport

This feature allows you to define the area
or zone to be imaged. Use for batches of
same-sized documents. If you select this
option, you can use the arrow keys to
define the x and y offset values, width and
length to redefine your scanned area. The
Display window will show image placement
as you change the values.

EOP (End of
Page)
Detection

This feature allows you to define the area
or zone to be imaged. Use for batches of
same-width but different length
documents. If you select this option, you
can use the arrow keys to define the x and
y offset values, width and length to
redefine your scanned area. The Display
window will show image placement as you
change the values.
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The following options are only available when Fixed to
Transport is selected.

. X-Offset — the distance from the left end of the
scanner to the left edge of the scanning area.

. Y-Offset — the position from the top end of the
document to the top end of the scanning area.

. Width — the width of the scanning area.
. Length — the length of the scanning area.

. Center: automatically calculates the x-offset for center-
fed feeding based upon document size selected.

o

. — relocate the scan area by click the arrow key on
the cross sign while retain the scan size. View the result
from the Display window.
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Example : Redefine your scan area ( x-offset: 2.25 inches ; y-
offset:1.13 inches)

Scanner Properties

Imegz | Compression | Color Dropout  Paper IPIBV]BW | Options | Setting | Informsation |

Cropping [Foed to Tramspot 7|
r — 1 | Scan
Soan Area: [one) e
o = Area
EOffset, 235+
F-Oifset EEE= S
Width: 49D§|| _— Dlsplay
Length 714 | [ Center .
Oversican. T = I = window
Top 0.00 | Botiom [
Mult-Feed Deteetion
¥ Additions] Length Detection 102

I™ Ultrasonic Detection
[ Stop Scanning after Multi-Feed

Clear the Multi-Fed Paper, & Manual o
Multi-Feed Alarm: (Mone) = | Bows
Uait: Tnches =]

Defaults... Sean Close

Original After Fixed to
Transport

The Redefined Scan Area

4-27



4.5.2 Other Paper Selection

Deskew

Use this option to automatically deskew a document.

KOHIKANIH N

i S e Note: If the skew angle is
iR OB too great, some of the
IE= = image may be cut off.

¥ -
| B

Scan Area

Choose your desired paper size with the drop-down list box. Or
you may select a custom paper size by clicking the Scan Area
box and then click Add to include in the choice.

Choice: None, US Letter- 8.5”x 11”, US Legal — 8.5” x 14”,
ISO A4 — 21 x 29.7 cm, ISO A5 — 14.8 x 21 cm, ISO A6 — 10.5
X 14.8cm, ISO A7 — 7.4 x 10/5 cm, ISO B5 — 17.6 x 25 cm,
ISOB6 —12.5x 17.6 cm, ISO B7 — 8.8 x 12.5 cm, JIS B5 —
18.2 x 25.7cm, JISB6 —12.8 x 18.2cm, JISB7 — 9.1 x 12.8
cm, Scanner Maximum, Long Page.

Long Page:

When you need to scan documents whose length exceeds
scanner maximum, please choose Long Page. Note if Long
Page is selected, the Multi-Feed Detection will not be available.
Options: Unknown Length, Enter Length (Note: This option
varies due to type of scanner.)
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Choose “Unknown Length” if you have a batch of long page
document with unknown length. Choose “Enter Length” to
enter the length and width of your documents or your desired
scan size on documents. This is useful when you have a batch
of documents with the same scan size or a batch of same-sized
documents.

OverScan

Overscan allows you to add a specific margin at top and bottom
or right and left (Options vary based on the type of scanner) of
the edge of the image. This is used to reduce possible corner
clipping on the skewed images and often applied to a batch of
skewed document to be scanned in the auto document feeder.
Select a value between 0 and +5 mm. Note the overscan
result will not be shown in the Display window and that the
availability of the function varies based on type of scanner.

Multi-Feed Detection

Multi-Feed Detection allows you to detect overlapped document
that go through the auto document feeder. Multi-Feed usually
occurs due to stapled documents, adhesives on documents, or
electro-statically charged document. Note : The availability of

the function varies based on type of scanner.

Additional Length Detection

Additional Length Detection allows you to define the length of
document being multi-fed. This value indicates the additional
length exceeding your scan area. The Display window will
show the size of the document as you change the value. A
value of O indicates no additional length detection. The
Additional Length Detection is best used when scanning same-
size documents in the auto document feeder.
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Example : Additional Length Detection : Set Additional
Length to be 2.02 inches

Scanner Properties [

Image ] Compress:inn] Color Dropout Paper lPxeview ] Optons] Sething ] Infonmton}
Cropping: | Fized to Transport ]|
r
Soan Area: | @one) =l -
¢ Portrait ™ Landsape
E-Otfset: 225 2|
T-Offset [ = ;ﬁ t — 11— 2.02”
Width: R .
Length: m:‘ [ Center
Overfcan: ’7:‘ ’7:‘
Top: IW:‘ Eottom: ’W:‘
Multi-Feed Detection
[ Additional Length Detection: IW:‘
[~ Ultrasonic Detection
IV Siop Scanning after Multi-Feed
Clear the Multi-Fed Paper: {* Manual " Auto
Multi-Feed. Alarm (ons) = ﬂ Browse...
Unit: [Tnches ~|

Defaults... Scan | Close |
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Ultrasonic Detection

Ultrasonic Detection allows you to set overlapped document by
detecting paper thickness between documents. Note : The
availability of the function varies based on type of scanner.

There are two options available if Multi-Feed is detected.

e Stop Scanning after Multi-Feed

If this is selected, the scanner will stop the feeder and
display the following Warning dialog box if multi-feed is
detected.

' E Multifeed iz detected, please remove the rest paper from ADE.
[

Action:

1. Follow the instruction on the Warning dialog box to
remove the rest pages on the feeder.

2. Click OK to close the Warning dialog box.
3. Scan the rest pages.
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Clear the Multi-Fed Paper:

Choice: Manual, Auto

If Auto is selected, once multi-feed is detected and scanning
operation is stopped, the scanner will automatically clear the
transport of the multi-fed paper.
multi-feed is detected and scanning operation is stopped, you
need to manually clear the transport of the multi-fed paper.
Note: The availability of this option varies based on type of

scanner.

Scanner Properties J

Tmage ] Compremn] Color Dropout  Faper lPrewew] Ophuns] Setting ] Infnmahun]

If manual is selected, once

Cropping: | Fizeed to Transport -
r~
Scan Area: [ Mamne) JE2
(s Portrait (" Landscape
E-Offet: 235 = £
¥-Offset: [ Jﬂ
Width: EETS z
Length ’W:‘ [ Center
OverScan: ’—:I ’—:I
Top: ’w:‘ Blottom: ’w:‘
Multi-Feed Detection
[ Additional Length Detection: 202 :I
[ Ultrasondc Deteotion
Iv Stop Seanning after Multi-Feed
Clear the bult-Fed Paper & Manmal © ot |
Multi-Feed Alarm: (Nome;) — ﬂ Browss...
Unit: [Inches -

Defaults.
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e Multi-Feed Alarm

If a wave file is added, the scanner will make a sound
alarm if multi-feed is detected yet no Warning dialog box
will be displayed.

If “Stop Scanning after Multi-Feed” is selected, the scanner
will stop the feeder.

If “Stop Scanning after Multi-Feed” has not been selected,
the scanner will continue to scan till the end of your
document.

Action:

1. If “Stop Scanning after Multi-Feed” is selected, follow
the action described in the preceding section “Stop
Scanning after Multi-Feed” on the previous page to
complete your job.

2. If “Stop Scanning after Multi-Feed” has not been
selected, rescan the pages where multi-feed is
detected.

How to add the sound alarm :

1. Click the Browse button on the right side of the speaker
icon. The Open dialog box appears.

2. Choose your wave file.

3. Click the Open button. The wave file is added.
Units

Defines the primary measurement system. Inches,
Millimeters, and Pixels are available.
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4.5.3 Relative to Document

Relative to Document: (used for batches of same-sized
documents)

This option allows you to crop different areas on your
documents and deliver these images in B&W, Gray, or Color
separately. For example, there are applications which require
you to store the entire document in B&W and a part of the
document in color to save storage space. This is useful for
documents where a photograph, or signature appears in a
consistent area on the document such as resumes, and so on.

The following procedure describes how to reproduce the entire
document in B&W and a portion of document (picture) in color.

1. On the Paper tab, choose “Relative to Document” or “Fixed
to Transport” from the Cropping option.

2. Choose your scan size from the Scan Area option. The
selected scan size will be displayed in a red rectangular
box. This is also the scan size of your entire document.
(For example, 1SO B5. If you have not chosen a scan area
and leave the selection as None, then the default area will
be the scanner’s maximum.)

loage | Comprrson | Color Dusgont Paper | Preview | Opbons | Settng | Informabon
1 7 o M
2 e —— Ared
'[ rectangular
|[ box
OvesSenn [ |
Tap: [ 000 = Botom |
Ml Feed Dution
7 Addisisnal Length Detestion: [
I~ Uisoni: Dewcson
W Swp Seanting afwer Melt-Feed
Clras the Miti-Fed Fapac & Miaml © Amn
Mudi-Feed Al Mhone) H & toe. |
Ui [Trches -]
Dt Sean Cles
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3. Click the Preview tab to display the Preview window. A
black rectangular box appears to indicate the max. scan
size your have just selected.

Zeanner Properties

Image | Compression | Color Dmpent | Faper  Preview | Options | Setting | Indormation |

T —
The Ima_ge P 7= The selected
Selection == E image
Box iR
i Feaz Auke Color Deteesion ,,_;
— ‘3 A black
W‘ ; rectangular
— box
YOttt [ _ n _;
Walih [z e
Lot [ = b
Unet [10hes =| "

Doty Frovow | sem | e |

4. Click the Preview button to view the entire image in low
resolution to correctly crop your relative scan area.

The Preview
Image

The Preview
Button

5. Select image type from the Image Selection box. The
selected image will appear in highlighted color. (For
example, Front Color)

6. Place your cursor on the Preview window and click your
left mouse button. A cross sign will appear as illustrated.
Create your relative scan size diagonally by dragging the
left mouse button to your preferable size. The selected
area will appear in a red box as illustrated.
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A Cross
Sign

Ioags | Comgovesion | Colos Duopost | Pepes  Fowview | Options | Bvsing | Indormation

The
Relative
Area

Check the B&W image from the Image Selection box to
scan the entire document.

Click the Scan button to start scanning the document in
two image types and sizes. (See the result in below.)
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4.6 The Preview Tab

The Preview tab allows you to preview (a low-resolution scan)
your image before final scan. This preview image lets you
allocate your scan area. You can choose your scan area by the
“Scan Area” drop down list box or placing your cursor on the
Display window and dragging it diagonally on the Display
window. Then, a red rectangle box will appear to indicate the
selected area.

Note: If you choose “Automatic Cropping” on the “Paper Tab”,
then to select a scan area on the Preview tab is not allowed.

Scanner Properties |

Image | Compression | ColorDropout | Paper  Preview }Opmm} Setting | Information |

[_|Front &nto Color Detection The Dlsplay
[IRear Ao Color Detection Wi ndow
Sean Area:
150 B5 - 176 3 250 mn Ed|
" Portrait r
EOffet 078 =
T-Offet 0.00 =
Width: 6.93 j
Length: 9.84 j
Tnit: Tnches hd
Defaults.. Preview | Scah ‘ Cloge:

The Preview Tab
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4.7 The Options Tab

The Options tab allows you to set following additional image
processing settings.

Scanner Properties f5_<

Image I Cnmpnemiﬂn] Cn]nrDmpnutl Paper ] Preview Cptions ISeth'ng } Infﬂmﬁnn}

Rotation

Rotation Deguees -
Blank Page Removal

[~ Blank Page Removal Threshold: J

Edge Fill

(+ White
0 Millimeters

" Black
Image Control Options
[~ Minmr
Background Setting
{+ White Background " Black Background

Defaults.. Scan ‘ Close

The Option tab dialog box
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Flip Side Select “fanfold” to rotate the image
Rotation of the reverse side to 180 degrees.

This is applied to double-sided
document which are viewed in
portrait are sometime fed into the
scanner in landscape or vice versa.

Choice: Book, Fanfold.

If “Book” is selected, the image of
the reverse side will not be rotated.

The following illustration shows the documents which should
be viewed in portrait are fed into the scanner in landscape

| g3 > mi
2 =

: g
} ‘ BB
208 g o4 &
S0 BE L] E

BH 8 0]
gajs 2 ‘ i 58 B
b = v [ w3 ]

14 o4 #s

2m

/! =g

| g

e

B2

an

1

bt |
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Rotate Image Choose the rotation angle from the
drop down list if you wish to rotate
your scanned image.

Choice: None, 90°CW/(clockwise),
90°CCW/(counter clockwise),
180°.

123

¢C1

Original
rigina Rotate 90°CW

¢ C1

123

Rotate Rotate 180°
90°CCW

Blank Page Check if you wish to remove the

Removal blank page and move the slider to
the left or right to your desired
threshold.
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Edge Check White or Black if you wish to add white or

Fill black edge on the border of your scanned
image. Enter the value from 0 to 5 mm. Default
value is 0.

Original

Image Check the Mirror box if you wish to reverse the
Control right and left side of your image.
Option

W

ot

The Mirror Eect
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Background  This option allows you to set your scan
Setting background.
Choice: White Background, Black
Background.

Black Background
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4.8 The Setting Tab

The Setting tab allows you to set the following settings:

Scanner Properties &

Image] Eompression] EolorDropout] Paper ] Preview] Options  Setting ] Information]

Energy Saving Control

ﬂ J ﬂ 15 mirutes

Barcode Detection
I” Enable

[v Ehow Scanning Progress
[v Ehow Warning Message
[v Bave Settings after Closing

Defaults... Scan Close

The Setting tab dialog box

Energy Saving Check the Enable Energy Saver box

Control and move the slider to the right to set
the amount of time to start the energy
saver after your last action. The range
is from 1 to 240 minutes. The default

is 15 minutes.
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Batch Scan
Setting

eBatch Scan

To increase the scanning speed, the
scanner first scans a few pages of your
document and then sends these scanning
data to the application. Therefore, during
scanning, the numbers of pages been
scanned on the scanner is somehow
different with the numbers of pages
displayed on your computer screen.
Choose this mode if you wish to complete
your scanning task at the fastest speed.

ePage Scan

If you choose Page Scan, during scanning,
the scanner will first scan only one page of
your document and then send the scanned
data to the application and then scan the
next page and send the next data to the
application, and so on. Therefore, in this
mode, the scanning speed is slower yet this
helps to keep the same scanning progress
between the scanner and your computer
screen.

Barcode
Detection

Check this option to enable detecting and
recognizing barcode in your document.
After the detecting process, an
avbarcode.ini file will be generated and
stored in your system drive, for example,
Windows\avbarcode.ini.

Note: The availability of this feature varies
based on type of scanner.
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Show Scanning
Progress

Check and the scanning progress bar
will be shown during scanning.

Show Warning
Message

Check to show the warning messages
such as “ADF pad count exceeds
50,000 scans (the number varies based
on type of scanner). Please replace the
ADF pad and reset the pad count.”

Save Settings
after Closing

Check to save your scanner properties
settings after leaving the dialog box.
Next time when you open the Scanner
Properties dialog box, the previously
saved settings will be shown.
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4.9 The Information Tab

The Information tab displays the following system and scanner
information.

Scanner Froperties gl
Image ] Compression } Color Dropout I Paper } Preview ] Options I Setting  [nformation I

Port Tupe B ~

1D/ Address: URE

Optical Resolution: 600 dpd

Scammer Model: AN

Serial Nuimber: G20CN1065M5T1400052

FW Version: 0.180

Background: White Background

Bomn Date: 20065/

First Scan: 20067744

ADF Fad Count: 142 Reset Pad Count |

ADF Roller Count: 138 Reset Roller Count |

ADF Count 137

Flathed Count: 463

Multifeed Count 3052404277

JTam Count: 730247176 v
Report
Defaults.. Close

The Information tab dialog box

The “Report” button :

If you encounter any error message while using the scanner,
click the Report button. A report.txt file (C:\AVxxx) will be
generated. Please send this file to the nearest service center
for trouble shooting.
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The “Reset Pad Count” button |

After scanning approximately 50,000 pages (the number varies
based on type of scanner) through the Auto Document Feeder
(ADF), the ADF pad may be worn out and you may experience
problems with document feeding. In this case, it is highly
recommended to replace the ADF pad with a new one. (Please
refer to the manual for proper replacing procedure.) For
ordering the ADF pad, please consult your nearest dealer.

After replacing the ADF pad, click the “Reset Pad Count”
button to reset the pad count.

The “Reset Roller Count” button |

After scanning approximately 200,000 pages (the number
varies based on type of scanner) through the ADF, the ADF
roller may be worn out and you may experience problems with
document feeding. In this case, it is highly recommended to
replace the ADF roller with a new one. (Note the replacement
of the ADF roller has to be performed only by authorized
service center. Therefore, please return your scanner for roller
replacement.) After replacing the ADF roller, click the “Reset
Roller Count” button to reset the roller count.

Note :

The lifetime and the replacing procedure vary based on type of
scanner. Please consult your nearest dealer for more details.
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5. ISIS Interface Operation

The ISIS driver operation method is similar to the TWAIN'’s.
Every function on the ISIS interface screen is briefly described
as below:

* Manual At

Diefault
Wl = w0

Cancel
Darken I Morm I Lighten I

|Black and Wwihite |

Diats per inch: Area..
[300 =] ! =
Page Size: Contrast-

[45-14.8%21.0cm | | Manual e

FI=DFLT Yersion 55.1.260.851 | P |

Avizion PN Driver Y2.01.062402

Mode: Select one of scan modes, including B&W, gray, color
options.

Dither: 5 halftone levels available, can be disabled.

Dots per inch: Select your desired resolution.

Paper Size: Select your desired paper size.

Brightness: Adjust your scan image brightness or darkness.

Contrast: Adjust the range between the darkest and the
lightest shades in the image.

Default: Click to reset all settings.

Area: Select your desired scan area or position.
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6. Using The Button

The convenient buttons on the scanner is shown as below:

Function Display ) The Scan Button
Function Selector
The Cancel/Stop Button
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6.1 Installing Button Manager

To use the buttons on the scanner, you need to install the
Button Manager. To ensure the Button Manager work properly,
please FIRST install Button Manager before installing the
scanner driver.

Installing the Button Manager is easy. Insert the supplied CD
to your CD-ROM drive and follow the instructions on the screen
to complete the installation of the Button Manager.

Button Manager provides you an easy way to scan your
document and then link the scanned image to your designated
software application. All this can be done by a simple touch of
the button on the scanner. Yet, before you scan, it is
recommended to check the button configurations first to ensure
a proper file format and a destination application.

6.2 Checking the Button Configurations Before Scanning

1. Click the Scan button on the scanner.

2. The Button Panel is displayed in the Windows System Tray
at the bottom right corner of your computer screen.

/ This indicates the scanner model

: x|

H @ Archive B

S
— | [ The Function

H =R Icon

H ‘E,/ W (The number of
¥ function icons

S i vary based on
® o | bpeo

scanner.)
The Button = qj;,",r: 02:06 P

Icon
The Button Panel
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3. The Button Panel shows the first five scanning buttons.
Right-click the button (function) you wish to check. The
Button Properties window appears.

Click to select

: _options or
Buiton Properiies g‘ setti ng ;
Menu | Options || Setting
The button Chagss 4 caufiguiation The scan
3 s W) B&W, 150 A4, 200dpi = .
Egmger and __,H_\.rc.hnc settings for
: Choon » decttion the selected
G button. (in
this case
button #1).
The file The destination
format of the application.
scanned ——— [ Adobe POF Properties | [ Add/Delete | (This is the
image. (*The 7|~ a2l nl & 8l e licati h
. e & & application that
options vary ﬁﬁﬁ@ﬁ opens after you
based on have finished
type of scanning.)
scanner.)

The default setting is indicated in highlighted color. If you
wish to change the setting, use this window to reset the
setting for the file format, destination application, or other
scan settings. See “Configuring the Button” in the
subsequent section to reset the settings.

4. Click the OK button to leave the window.
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6.3 Scanning From One Touch of the Buttons

1. Adjust the paper guide for the width of paper and load the
document with their tops into the automatic document
feeder.

2. Check the number on the LED screen to ensure if you are
selecting the proper scan settings and destination
application. (For example, if you want to scan with button
#4, which open Microsoft Paint and display the scanned
image in the main window of Microsoft Paint, the LED
screen should show 4).

3. Press the Scan button on scanner.

4. After the scanning is finished, the Microsoft Paint software
will be launched and the scanned image appears in the
main window of Microsoft Paint as below.

o General Document foding mode Fiatbed.
4’ T T —
h . Scanningspeed
i ﬁ:‘nnn papas sizo
ADF max. paper size
Fiatbed max, paper size
B e
__ ;}:‘:‘:nmms:n xWxD)
Weight
Copy First copy out | Colar mods
Spec Color copy speed
BW capy speed
_Copy resolution
. Copy scaling |
Muftiple copies -
[ mepmaegaeasans
Note:

For details information on how to use the Button Manager,
please refer to the user’s manual in the supplied CD.




7. Care and Maintenance

7.1 Cleaning the ADF

Your scanner is designed to be maintenance-free.
However, it still needs to be cleaned occasionally to ensure
optimum image quality and performance.

The scanner parts may be contaminated with ink, toner
particles or paper coatings. As a result, the scanner needs to
be cleaned occasionally particularly in the following cases:

1. Documents do not feed smoothly or easily;
2. Several documents feed at one time.

The cleaning procedures

1. Wet a cotton swab with some isopropyl alcohol. (95%)

2. Open the ADF unit as shown below and wipe the upper
feeding roller by moving the swab from side to side. Rotate
the roller forward with your finger and repeat the above
cleaning procedures until the entire roller is cleaned. Be
careful not to snag or damage the pick springs.

3. Wipe the pad in the direction from top to bottom. Be
careful not to hook the pick springs.

4. Close the ADF unit. Your scanner is now ready for use.
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7.2 Cleaning the Glass
The procedures

1) Soak a cotton swab with some isopropyl alcohol. (95%b)
2) Open the ADF unit and document cover as shown below.
Wipe the glass of flatbed and ADF area by moving the

swab from side to side.

3) Close the ADF unit and document cover. Your scanner is
now ready for use.

glass
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7.3 Replacing the ADF detachable pad module

After scanning approximately 20,000 pages through the ADF,
the pad spring may be worn out and you may experience
problems with document feeding. In this case, it is highly
recommended to replace the pad module with a new one. For
ordering the pad module, please consult your nearest dealer
and follow the procedure in below to replace it.

Removing Procedure

1. Open the ADF front cover.

2. Remove the ADF detachable pad module by pulling out
the upper part of the pad clamp as shown in the figure
below.
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8. Troubleshooting

If you have problems with the operation of your scanner,
please check the following troubleshooting hints.

8.1 Frequently asked Questions

Question: Paper becomes jammed during scanning.
Answer: 1) Open the ADF unit.

2) Pull out the jammed paper carefully.

3) Close the ADF unit.

Question: More than one sheet of paper were fed into
the scanner.
Answer: 1) Open ADF unit.
2) Remove the multi-fed sheets of paper.
3) Close the ADF unit.
4) Flatten the corners and edges; loosen the
Paper before reloading it in the paper
guide.
5) Check the feeding roller condition and do
the cleaning if necessary.

Question: Paper becomes skewed in the scanner.
Answer: 1) Check the feeding roller condition; do the
cleaning if necessary.
2) Use the paper guide when feeding the
paper.
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Question: When | power on the scanner, it makes noises
and will not stand ready.
Answer: There are two possibilities:

1) You forgot to remove the shipping lock from
the scanner. Please remove the shipping lock
first.

2) You did not place the scanner on a flat desktop
surface. This may cause the scanner to function
improperly.

Question: While scanning, the scanner often makes noises
or it scans back and forth.
Answer: Please choose lower speed from the TWAIN
user interface for low speed PC.

Question: The scanned image always comes out to be
too dark.

Answer: 1) Use your application to modify the Gamma
setting to 2.2 and 1.8 for your printer and
monitor respectively.

2) Adjust Brightness setting from the TWAIN
interface to get a brighter image.

Question: The scanner works well except for the line art,
the lines of which seem much thicker than the
original.

Answer: Increase the Brightness or adjust the Threshold

setting to adjust the line art image.
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8.2 Technical Service

Before contact Avision, please prepare the following
information:

®=  Scanner serial & revision number (located on the bottom of
the scanner);

= Hardware configuration (e.g., your host CPU type, RAM size,
free disk space, display card, interface card);
The name and version of your scanning software application;
The version of your scanner driver.

Please call us at:

Headquarter

Avision Inc.

No. 20, Creation Road I, Science-Based Industrial Park,
Hsinchu 300, Taiwan, ROC

TEL: +886 (3) 578-2388

FAX: +886 (3) 577-7017

E-MAIL: service@avision.com.tw

Web Site: http://www.avision.com.tw

US and Canada Area

Avision Labs, Inc.

6815 Mowry Ave., Newark CA 94560, USA
TEL: +1 (510) 739-2369

FAX: +1 (510) 739-6060

E-MAIL: support@avision-labs.com

Web Site: http://www.avision.com

8-3



9. Specifications

All specifications are subject to change without notice.

Model Number

Scanner Type

Scanning Mode

Optical Resolution

Light Source

Maximum Scanning Size
Interface

Power Requirements
Power Consumption

Humidity
Operation Temperature

Storage Temperature
Dimension
Weight

DL-0710H

Flatbed & ADF
Color/Grey/Black & White

600 x 1200 dpi

Cold cathode fluorescent lamp
8.5"*14"

High Speed USB 2.0

24Vdc, 2A

< 40 watts

20—~85%RH
10—35C

-40 to 65°C

567*350%199 mm(W*D*H)
7.08Kg

9-1





